
2D Objects are two dimensional objects imported in Windows metafile (WMF & EMF) format or Xara WEB & XAR 
format. Use Import on the File menu to import 2D objects



Creating 3D buttons
You can use Xara3D to produce round and rectangular 3D buttons.
To create a 3D button

1. Select the design you would like to use as the basis of your button.
2. To change the size of the button change the Font Size.
3. To change the width of the button change the Aspect ratio.
4. From the View menu choose Text Texture.
5. Create a suitable message for your button.
6. If you want to make the wording larger or smaller, click the X button on the Xara3D Toolbar. This displays the 

Texture dialog box.
7. Increase Size until the text is the required size. (You will need to change the texture size if you make the 

button wider or narrower in step 3.)
8. Light 1 sets the basic color for the button. Edit this if required. (Lights 2 & 3 create the shading and highlights.)

If the button doesn't have the right bevel or extrude depth, you can edit these in the regular way.
There's more information on the on-line web pages  and in the ReadMe.txt files in the Buttons and Words 
folders.



Altering the 3D extrude
Pressing the 'E' button (or ALT+E on the keyboard) displays the Extrusion Options dialog box. This lets you 
change the extrude 3D depth.
More information on the Extrude Options dialog box.



Altering the Bevel
To adjust the bevel (the type of corner applied to edges):

1.Press the ‘B’ button to display the Bevel dialog box.
2.Select from the list of bevel types.

Set the bevel size by typing into Depth.
Select Miter or Round (see notes).

Notes:
You can also type ALT+B to display the Bevel dialog box.
Bevels go along the sides, not the face. So, for example, selecting the 'Curved' bevel produces a budge 

effect to the extruded part.
Beveled objects are slower to display than objects with no bevel.
The Miter and Round options affect the corners of objects. Usually text has sharp mitered corners, but 

you can round the corners by selecting Round. This is usually only obvious for fonts that have sharp corners or 
serifs.



Altering the background color or texture
To use a flat color as the background behind the text:

1.Choose Background Color from the View menu. This displays the Color Picker.
To use a bitmap texture as the background:

1.Choose Background Texture from the View menu. 
You can also drag-and-drop textures onto the background.
Bitmap texture backgrounds are useful where you want a 3D text heading to appear on a web page that has a 
texture background.    Using the same bitmap as the web page background ensures that any 3D heading 'fits in' 
with the whole page background. You can import any BMP, PNG, JPEG or GIF file as a background and Xara3D 
repeats this (tiles it) in exactly the same way as a Web browser.

Note for Version 2 users:
The texture is now stored in the X3D file. If you give the X3D file to someone, you no longer need to give them the 
texture file as well. 



Altering the font
Use the drop down list on the Text Toolbar (at the bottom of the window) to alter the font. Any installed TrueType 
font is available in the font list. With Xara3D you may find that some of the more unusual block and ‘curvy’ fonts 
work particularly well.
Click B (or press CTRL+B) to make the text bold.
Click I (or press CTRL+I) to make the text italic..
Note:

You can also click the "T" button at the top of the window to display the Text options dialog box. This lets 
you preview the different fonts installed on your computer. Click on a font name and use the up/down cursor (arrow)
keys on the keyboard to step up and down the list of fonts.



Altering the lights
Xara3D has three lights shining on the objects. These lights can be any position and color . 
To view the lights:

1. Press the ‘light bulb’ button. (You can also press CTRL+TAB.) 
This shows the three lights, represented by colored arrows. A fourth arrow (striped arrow) controls the position of 
the shadow.
To change the color of a light:

1.Double click the appropriate light arrow. This displays the Color Picker.
Details of changing the color of the shadow.

To reposition a light:
1. Drag the arrow. This rotates the light around the text object. 

To move a light behind the objects, just keep dragging right or left until it rotates behind the objects.
Notes:

An alternative way to control the light colors is right-click on the window. Or use the View menu. Either 
brings up a pop-up menu that lets you control all three lights as well as colors or bitmap textures.

You can rotate the lights in animations - see Creating an animation.



Altering the Shadow
Xara 3D version 3 includes an advanced shadow tool that can give a very realistic effect of the object hanging in 
front of a surface. The position of the shadow is controlled by one of the arrows in the lighting control. The shadow 
blur and darkness is controlled from the Shadow Dialog Box - click the S button. You can even control the color of 
the shadow for special effects.
Note: GIFs with shadows are usually larger than with no shadow. Also the further the shadow is away from the text, 
or the more blurred, the larger the file. To get the most realistic shadow effects on your web page, ensure the 
Xara3D background matches that of the web page. See the Shadows and Backgrounds for details.
What do you want to do...

adjust the shadow position?
blend the shadow into a background?
display or remove the shadow?
change the shadow style (type)?
change the shadow color?
change the shadow transparency?
change the shadow blur?



Altering the text
Maximum number of characters: 80
You can either directly edit the text in the window or use the Text Options dialog box. Text Options is easier to use 
when editing complex text that is slow to redraw on screen. Click the 'T' button to open the Text Options dialog box 
(or press ALT+T.)
What do you want to do...

add characters to the end of the text?
delete characters from the end of the text?
start a new line?
add or delete characters in the middle of a line??
change only selected characters?
change the spacing between characters?
make characters wider or narrower?
change the spacing between lines of text?
change the alignment of lines of text?
make text hollow (outlined)?
type in accented (international) characters?



Altering the text color
You can make the text any color. This color is then modified by the three lights shining on the text.
Changing the text color:

1.Choose Text Color on the View menu. This displays the Color Picker. 
If you select anything but a very light or pale color you'll find the light colors have relatively little effect.

Shiny or matt text surface
The surface of the text can be shiny or matt - this alters the reflectivity of the surface. The Extrude dialog box 
controls this. Press the 'E' button (or ALT+E on the keyboard) to display this dialog box.
However the difference won't always be obvious unless the lights are at the necessary angle to reflect off the 
surface. This is usually by moving a light behind the text (keep dragging the light right or left so it goes behind) so it
can reflect off the surface of the text.
See also:
Coloring the text using a texture



Animation dialog box
You can create Animated GIFs and AVI movies using Xara3D. You can preview the effect of the current Animation 
settings by clicking Start/Stop Animation on the Toolbar. More details of creating animations.
To display this dialog box:

1.Either click the Animation Options button on the Toolbar at the top of the window
or choose Animate on the Window menu
or press ALT+A.

Frames per revolution
This is the number of steps in the animation sequence. The greater the number of frames the smoother the 
animation. The drawback is that the file is bigger - this is a big disadvantage for web graphics. You may need to try 
different values to get the best results.
Frames per second
The animation speed. Slow speeds can give jerky movement. High speeds can also give jerky movement as the 
program displaying the animation may not be able to keep up. Again you may need to try different values.
Pause
You can only pause animated GIFs not AVI movies.
This pauses the first frame before continuing the rest of the animation. Type in a value in centiseconds (1/100ths of 
a second) - a 2 second pause is 200 cs. Note that this applies only to the first frame; use Frames per revolution 
and Frames per second to control the overall speed of the animation.
Style
This controls the type of animation:
Rotate options:

Rotate 1 rotates all the text as one; Rotate 2 rotates each character.
Front face only - normally the animation shows only the front face of the text and not the back. This looks better

and makes the exported file smaller (because there's only half the number of frames.)
Rotate text/Rotate lights - select whether you want the text to rotate or the lights or both. You cannot rotate 

the shadow as this would create very large files.
Direction - selects the direction of rotation.

Swing options:
Swing 1 swings all the text as one; Swing 2 swings each character.
Angle - how much you want the text to swing.
Direction - selects the plane of rotation. Clockwise only has an effect if you Pause the animation.

Pulsate options:
Pulsate 1 pulsates all the text as one; Pulsate 2 pulsates each character.
Minimum text size - how far back to pulsate the text.
Shrink/Grow - only has an effect if you Pause the animation. These options select the starting point for the 

animation (maximum or minimum.)



Bevel dialog box
The bevels are the joins between the face and sides of the 3D objects, More details on using bevels.
Bevel types
Select from the list.
Miter/Round
These affect the corners of the letters. Miter gives square edges; Round rounded edges. Which you use depends 
on the effect you want.
Depth
This is the depth (size) of the bevel.



Example 3D graphics
These are in the Examples folder. You can use these examples as templates for your own heading. Find an example 
similar to the heading you want to create. Customize it to your requirements and then export it. Simple.
Examples are divided into categories to make navigation easier.



Textures:
These can be used either on the face of your headings or as backgrounds behind them. Textures are regular GIF 
files so you can use them as background on your web pages. 

Using textures to color headings 
Using background textures

Textures are divided into Coarse (very large patterning), Medium, and Fine (small patterning.) These are subdivided 
into high contrast (large color changes), middle, and low contrast (subtle color changes.)
Wood & Stone are collections of textures based on wooden or stone/gravel photographs. All these textures are 
duplicated in the Coarse, Medium, or Fine folders.
Words are text messages that you can use to create 3D text buttons - more details.



Changing the shortcut
Installing Xara3D places a shortcut to the program in the top level of the Programs menu. 
To move the shortcut to a submenu:

1.Right click on the Start menu on the Taskbar and select Open. 
2.Double-click on Programs. This displays the contents of the top level menu with Xara3D shown at the bottom. 
3.To move Xara3D to another folder simply drag-and-drop it over the desired folder.

To create a shortcut on the Windows desktop:
1.You can drag the Xara3D icon onto the Desktop to create a shortcut for launching the program.



The Color Picker
The Color Picker lets you select any hue and any shade of color. 
To adjust the shade:

1. Click or drag on the central area of the Color Picker. You'll see the exact color in the top right corner of the 
dialog box. 

To alter the hue:
1. Click or drag on the rainbow strip along the lower part of the dialog box.

HSV and RGB
If you want a exact color type in values:

HSV (Hue, Saturation, Value) Hue is a color wheel with values in the range 0-360 degrees. Saturation and Value 
are percentages.

RGB (Red, Green, Blue) Enter values in the range 0-255 or 0-FF (see Hex below.)
You can create the same range of colors using either HSV or RGB - use the one you are familiar with.
Hex
You can define RGB colors as either 0-255 (Hex off) or 0-FF (Hex on.) These are identical (256 steps), just different 
ways of showing the same value.
Many color lists show RGB colors as six characters such as FF057F. To use this color R=FF G=05 B=7F.



Help for Xara3D
Welcome to Xara3D, the ideal program for creating static 3D headings and animated 3D GIFs/AVIs in seconds.

If you enjoy using Xara3D 3 then you might like to give our latest version a try. This covermount CD should contain 
a free 15 day trial and demo movie, or you can find them on our website       along with a collection of example 
graphics, customer testimonials and press reviews. And, if you register this version of Xara3D 3, you can upgrade at
a special discount price.

You can read more about what's new in Xara3D 6 and how you can how to register and upgrade.

"I just bought Xara3d and it is so cool. It's so easy to use that I was able to re-design my company logo
in just ten minutes. It's worth 10x what you're charging but I'm glad it was so reasonably priced. Keep 
up the good work." -- Xara3D customer. 

An enhanced version of the user documentation is available on-line at www.xara.com/support/xara3D/helpv3/  
(Blue text and  denote links to an Internet page; click to go to that page.) 
Getting started:
These pages help you when you first install Xara3D.

Introduction
Installing the free fonts
Moving the Xara3D short-cut
What's new in version 6
License terms

How do I...?
Use these pages if you want to find out how to do something in Xara3D.

What does this do?
Use these pages to find out more about the menu options or the dialog boxes.

Other information
Customizing Xara3D
Direct3D
Keyboard short cuts
Hidden and advanced options
Uninstalling Xara3D
Technical support
Other Xara products

Web links:
Xara home page 

Xara3D home page     
Xara3D support 
Version 3.03cm January 2005
All trademarks acknowledged.
Xara, Xara X, Xara Webster and Xara3D, Xara ScreenMaker, Xara Menu Maker and Xara Online are trademarks of 
Xara Group Ltd.
Geotype, Greek Diner, Russel Write, and Whimsy fonts kindly provided by Gary David Bouton  
Other fonts are from a collection created by Fontbank Inc., which can be purchased from our web site 
www.buyfonts.com     
Certain WMF symbols are letters from EFF fonts - Creatures, Chess, Symphony, Picturesque, Birdie and ArrowPi - 
which are some of the variety of quality fonts from the EFF range which can be purchased from our web site 
www.buyfonts.com/ 



Correcting mistakes
You often need to experiment to get the best results. Xara3D makes this easy - if you don't like the result use the 
Undo button to discard the change. (Undo is also on the Edit menu or press CTRL+Z.) It's not just the last operation 
you can undo. Xara3D has unlimited undo so you can step all the way back to the beginning.
If you step back too far, click the Redo button (also on the Edit menu or CTRL+Y) to undo an Undo. You can use 
Redo at any time until you make new changes.



Creating a movie or Animated GIF
It's incredibly easy to create 3D animations and movies in Xara3D. You can preview an animation by pressing the 
Start/Stop Animation button. The 3D objects can rotate, swing or pulsate around their center. You can control the 
animation speed and frame rate using the animation dialog box available from the A button.
For rotating animations Xara3D includes an option to show only the front face of the objects. This restricts the 
rotation to 180 degrees so that, although it appears to perform a continuous rotation, it actually skips 180 degrees 
and text is always readable. This has another significant advantage of reducing the file size of the animation, 
particularly important for Animated GIFs. You can also choose 360 degree revolution if you want to see the back of 
the objects.
Steps to producing a movie or animation:

1.Resize the Xara3D window to the required image size. Remember that Animated GIFs need be very small to 
have an acceptable download time.

2.Select the Animation dialog box (the A button) and choose the number of frames per revolution. Again for 
Animated GIFs the fewer the better. 

3.Choose the number of frames per second (animation speed). A slow animation speed with only a few frames 
per revolution can give a jerky animation - you may need to experiment to get the best results.

4.Choose the animation style (type.) More details of the animation styles.
5.Select Export Animation on the File menu. Select AVI or Animated GIF file type. Give the file a name and press 

Save. This displays the Export quality dialog box where you can select the size, number of colors etc., see 
Export options for AVI movies and Export options for Animated GIFs

When previewing an animation, the program displays a much lower quality to be as fast as possible - however when
exporting an Animated GIF or AVI movie Xara3D always renders all frames at the maximum quality. To preview an 
Animated GIF simply drop the file onto your web browser window. 
Xara3D can produce, in minutes, top quality Animated GIFs and movies that would take hours using traditional 3D 
design programs.
See also
Previewing AVI movies
Tips for reducing the size of Animated GIFs



Customizing Xara3D
Displaying Toolbars
The Window menu lets you control display of:

the main Toolbar at the top of the window
the Text Toolbar at the bottom of the window
the Status Bar, also at the bottom of the window

Docking dialog boxes
The Extrude, Bevel, Shadow, Texture, and Animate options dialog boxes can be either free-floating (you can move 
them independently of the main window) or docked (attached to the side of the window.)
To dock a dialog box:

1.Drag the dialog box over either the left hand edge or right hand edge of the window. The dialog box outline 
changes to a thin line when it can be docked.

To undock a dialog box:
1.Drag the dialog box away from the window. The outline changes to a thick line when undocked.



Direct3D
Xara3D doesn't use Direct3D as the Xara3D engine is more advanced in many ways than the Microsoft Direct3D 
software solution (for example, the anti-aliasing). Obviously having a hardware accelerator would be faster; 
however these are also usually inferior and unpredictable quality and would not support the advanced features of 
Xara3D such as soft shadows.



Edit Menu
Edit
Display the text caret ready for on-screen editing of the text. More details of editing text.
Undo
Undo the last edit. More details of Undo & Redo.
Redo
Undo the last Undo operation. More details of Undo & Redo.
Cut
Delete the selected text and put it on the clipboard. You can then paste it as plain text into other applications. Note 
that this loses all lighting and 3D effects.
Copy
Similar to Cut except that this doesn't delete the text.
Paste
Paste the clipboard contents into Xara3D. This option is dimmed if Xara3D cannot interpret the clipboard contents. 
(For example, if the clipboard contains a bitmap.)
Delete
Discard the selected text.
Select All
Select all the 3D objects ready for editing.
Select Line
Select the line containing the text cursor. (By default the bottom line.) For a single line of text this is the same as 
Select All.



Export options for AVI movies
Experimentation has shown that exporting AVIs as 24-bit produces the smallest file size. Perhaps surprisingly, 
exporting as 256 color (8-bit) produces larger files but usually higher quality. This is because it uses a different 
compression system.
Current Window Size lets you export just the area surrounding the text (Crop on) or the entire window area 
(Crop off.) 
User Defined lets you specify the dimensions of the bitmap. With Fit to Width (on the Text Toolbar) selected, the 
text and the background scales to suit the values you type in. If you specified a font size, the size of the text does 
not change but the background scales to the values you type in. This is useful if you want to create several 
headings, all the same height and width.
Note. It’s very important to make sure the compression option is switched on. Even at 100% quality, compression 
makes the file up to 10 times smaller.
See also:
Creating a movie or Animated GIF
Previewing AVI movies



Export options for Animated GIFs
To learn more about exporting animated GIFs see Creating a movie or Animated GIF
Because Animated GIFs can be quite large, you may find that a 16 or 32 color, optimized palette per frame, 
produces the best results for the smallest file size. However you might need to experiment.
Dithering always makes GIFs look better, but also makes them larger. When outputting at 256 colors you may find 
that there is no need to turn dithering on.
Current Window Size lets you export just the area surrounding the text (Crop on) or the entire window area (Crop 
off.) 
User Defined lets you specify the dimensions of the bitmap. With Fit to Width (on the Text Toolbar) selected, the 
text and the background scales to suit the values you type in. If you specified a font size, the size of the text does 
not change but the background scales to the values you type in. This is useful if you want to create several 
headings, all the same height and width.
Pause lets the animation wait before starting each rotation. (The animation shows the first frame during the 
pause.) Pause applies only to the first frame; use Frames per Revolution and Frames per second in the 
Animation Options dialog box to control the speed of animation. Enter values in centiseconds (1/100ths of a second)
- a 2 second delay is 200 centiseconds. Note that you can pause only animated GIFs, not AVIs.
Note:
There is an issue with ‘optimized palette per frame’ with Macintosh web browsers. Unfortunately they all seem to 
have a serious bug that prevents per frame optimization working. If you know your audience consists of Apple Mac 
viewers then we advise you not to use per frame palette optimization.
See also
Tips for reducing the size of Animated GIF files



Export options for GIF, PNG or BMP
GIF export is the most common and probably the best format for use on the Web. GIF images can have no more 
than 256 colors, which you might think is a limitation. However, using Xara3D’s advanced dithering and palette 
optimization features, you can get near perfect quality images using only 256 colors. Indeed you’ll be surprised at 
how good GIFs with just 16 colors can be.
For all export formats you have control over not only the number of colors but also whether the image is dithered 
and has an optimized palette. These are techniques to improve the image quality while using a reduced number of 
colors. For example using only 16 color GIF nearly always produces the smallest file size, but with no dithering the 
shading can be poor. By using an optimized palette and diffusion dithering you can substantially increase the 
quality of the result.    
There are no hard and fast rules as to which combination of export options is best - it depends on the image and 
your requirements. Therefore we recommend exporting in a number of different formats to see which is the best 
and has the smallest file size. Typical options to try include 16 color with diffusion dithering, or 256 color with no 
dithering.
For examples of the different quality settings see the web page GIF quality settings 
When exporting as a GIF or PNG you have the option of making it interlaced    (progressive rendering as it’s 
downloaded) and whether the image is transparent.    For more details on the transparent options see the web page 
GIF & PNG transparency 
Current Window Size lets you export just the area surrounding the text (Crop on) or the entire window area 
(Crop off.) 
User Defined lets you specify the dimensions of the bitmap. With Fit to Width (on the Text Toolbar) selected, the 
text and the background scales to suit the values you type in. If you specified a font size, the size of the text does 
not change but the background scales to the values you type in. This is useful if you want to create several 
headings, all the same height and width.
Additional quality control:
Also available from Xara is Xara Webster, which you receive a free copy of when you purchase Xara3D5. Webster 
provides even more advanced color reduction facilities and can be used to further reduce the size of files by 
selecting intermediate numbers of colors. To do this, export the image as a True color 24-bit BMP image and use 
Webster to color reduce the file to a specific number of colors.
Also available from Xara is Xara X, the 'big brother' of Webster, with even more tools and features.
More details on Xara X 



Export options for JPG
JPEG bitmaps are always 24-bit, true color, but the JPEG compression system means that the quality is often not as 
good as a GIF.    The Quality setting determines how small the resultant file is - the higher the quality, the larger the
file. Quality settings less than 80% usually produce inferior images to those available from using palette optimized 
GIFs.
Current Window Size lets you export just the area surrounding the 3D objects (Crop on) or the entire window 
area (Crop off.) 
User Defined lets you specify the dimensions of the bitmap. With Fit to Width (on the Text Toolbar) selected, the 
3D objects and the background scale to suit the values you type in. If you specified a font size, the size of the 
objects does not change but the background scales to the values you type in. This is useful if you want to create 
several headings, all the same height and width.



Extrusion Options dialog box
Color
The opens the Color Picker ready to change the color of the 3D objects. More details of changing object color.
Gloss/Matt
Gloss make the object surface reflective, Matt non-reflective. The best results with Glossy requires careful 
positioning of the lights. See Altering the text color for more details.
Front Face
Switching off display of the front face creates hollow objects and can give interesting effects. See Hollow text for 
more details.
Back Face
Similar to front face but controls display of the back of the objects. This has no effect unless you also turn off Front 
Face or rotate animated text through 360 degrees 
Outline
Produces outline objects. This is different to switching off face display. See Hollow text for more details.
Outline Width
Controls the thickness of the outline. See Hollow text for more details.
Depth
Controls the extrude depth. See Extruding for more details.



File menu
New
Open a new document. You are warned if the existing document has unsaved changes.
Open
Open (reload) an existing Xara3D .X3D file. (A file previously saved using Save or Save as.) You cannot reload 
GIFs, JPEGs, AVIs, or PNGs exported from Xara3D.
Save
Save the document as an .X3D file. This lets you reload it back into Xara3D in the future.
Save as
Save the document under a different name.
Import
Lets you import a 2D object (Windows metafile.) Xara3D can then turn it into a 3D heading (more details.)
Export bitmap
Create a GIF, JPEG, or PNG bitmap file of the current document. Note that you cannot reload bitmaps back into 
Xara3D (except as background or text textures) so if you want to make further edits in the future, save the 
document as an .X3D file. (See Save and Save as above.)
Export animation
Create an Animated GIF or AVI movie of the current document.
Recent file list
A list of the last few documents edited.
Quit
Exit Xara3D



Hidden or advanced options
Wire-frame mode:
You can turn on a wire-frame mode that can speed up the moving and positioning. To do this press CTRL+SHIFT+W 
Press it again to turn wire-frame off.
Perspective:
You can adjust the Z distance of the objects using CTRL and + or    - keys on the numeric keypad. Note that at 
maximum zoom you get a rather unrealistic perspective, as if the image were very close to the eye, causing a fish-
eye lens effect. This exaggerates the perspective. The default perspective is about right for the typical distance 
these images will be viewed on screen.
To cancel any changes to perspective hold down CTRL and click * on the numeric keypad.
The following options are Registry entry changes. Do not attempt these changes unless you fully understand 
editing the Registry.
Editing mode
Registry key: Software, Xara, X3D3, Settings, Edit mode

0 - apply any changes (such as font or size) to the selected region or (if there is no selected region) to all text.
1 - apply any changes to the selected region or to new characters you type in.

Compact save
Registry key: Software, Xara, X3D3, Settings, Save compact

0 - save text and background textures as part of the X3D file. If you use textures, this creates larger files but is 
often more convenient.

1 - do not save textures in the X3D file. (This is how Xara3D release 2 worked.)



Creating hollow text
You can turn off display of the faces of the text (show only the sides) to create interesting effects. There are two 
options:

as outlined text with thick sides. Both the inside and outside edges show a bevel.
turn off display of either the front or back face. This creates totally hollow text - the sides are wafer thin 

and you can see inside the text. Only the outer bevel is shown.
The two options are illustrated on the web help pages - click here to view them 
To create outlined text:

1.Click Outline on the Text Toolbar.
Or, for more control, display the Extrusion Options dialog box. (Click the 'E' button.) This duplicates the Outline 
button and also lets you control the width of the outline.
To turn off display of the faces:

1.Display the Extrusion Options dialog box. (Click the 'E' button.)
2.Deselect Outline.
3.Deselect Front Face and Back Face for the result you want.



How do I...?
Use these pages if you want to find out how to do something in Xara3D.

     The basics  
Text & 2D objects:

positioning & rotating
changing the size
changing the wording
changing text spacing
changing the font
changing the color
changing the bevel (edges)
changing the 3D extrude (depth)
changing the lighting
creating hollow text
shiny & matt surfaces
selecting text
typing international (accented) characters
importing 2D objects
creating 3D buttons

Colors
changing the text color
changing the background color
changing the colors of the lights
changing the shadow color

Shadows
general information
adjusting the shadow position
creating and deleting shadows
changing the shadow color
changing the shadow transparency
changing the shadow blur
shadows and backgrounds

Textures
and text
and the background

The lights
changing their color
changing their position

Animation
creating an animation/movie
previewing an AVI movie

Saving
saving for reloading later
saving as a bitmap
graphics for the Internet
creating an animation/movie
previewing an AVI movie

Correcting mistakes
Undo & Redo



Installing the fonts
Included with Xara3D are some free fonts in a Font folder inside the Xara3D folder. You can preview the fonts by 
double clicking on them in this folder. 
To use these fonts in Xara3D or other Windows programs, you need to install them using the Fonts Control Panel. 
To install the fonts:

1. Open the Control Panel by double-clicking on Control Panel in My Computer. 
2. Open the Fonts Control Panel by double clicking on its name.    This shows all the TrueType fonts installed on 

your system.
3. Drag the fonts over the Fonts Control Panel window. 

Notes:
In step (1) you can also click Start on the Taskbar then choose Settings, Control Panel.
In step (3) you can also select Install New Font on the File menu of the Font Control Panel, and then 

locate the fonts where Xara3D was installed.
Two of the fonts downloaded with Xara3D are from the large range of fonts available for individual 

download at www.buyfonts.com 

The download fonts are:
Balthazar - an unusual old fashioned ‘pen’ font
Dayton - a modern blocky font



Introduction
Xara3D is a ‘slimware’ program as opposed to the increasingly complex 'bloatware' that is released from the major 
software developers nowadays. This does not mean that Xara3D is low quality or produces inferior results compared
to more complex 3D programs; on the contrary, it produces better output, and faster than just about anything else.
'Bloatware', while often very capable, includes so many features that most people never get to use more than 10% 
of the functionality. It's often huge, impractical to download over the Internet, requires huge amounts of disc space, 
and is nearly always so complex that to use its advanced features takes a considerable learning effort.
Xara3D is designed to be a program that does one thing, and does it supremely well, that is dead simple to use, and
costs very little. It's designed to be small enough to be easily downloaded from the Internet.
Xara3D produces high quality three-dimensional    images and nothing else. These images would typically be used 
on Web pages although they can be used anywhere. Xara3D can create animated rotating 3D images with absolute 
ease (AVI movie or GIF). You have control over the text, the font, the depth of the 3D extrude, the type of the bevel 
on the edges and the lighting. You can position and rotate the 3D objects just by dragging, and it updates the image
in real-time, interactively. You resize the image just by resizing the window. It couldn't be easier.



Keyboard short cuts
Open new document CTRL+N
Open existing document CTRL+O
Save document CTRL+S
Export image CTRL+SHIFT+E
Export animation CTRL+SHIFT+X
Import 2D object CTRL+SHIFT+I
Undo last operation CTRL+Z
Redo (cancel Undo) CTRL+Y
Open Animation Options ALT+A
Open Bevel Options ALT+B
Open Extrude Options ALT+E
Open Shadow Options ALT+S
Open Text Options ALT+T
Open Textures Options ALT+X
Display text bar CTRL+T
Display lights CTRL+TAB
Start/stop animation CTRL+SPACE
Cancel rotation ALT+HOME
1 degree rotation ALT+arrow keys
15 degree rotation CTRL+ALT+arrow keys
Change color of text ALT+C
Apply texture to text CTRL+SHIFT+C
Change color of background ALT+G
Apply texture to background CTRL+SHIFT+G
Edit light 1 color ALT+1
Edit light 2 color ALT+2
Edit light 3 color ALT+3
Edit Shadow color CTRL+SHIFT+S
Make text bold CTRL+B
Make text italic CTRL+I
Make character to right of cursor upper case

CTRL+U
Make character to right of cursor lower case

CTRL+SHIFT+U
Swap case of character to right of cursor

CTRL+W
Negative kerning F5
Positive kerning F6
Shift selected text up F7
Shift selected text down F8
Outline text CTRL+SHIFT+O
Display text cursor CTRL+E
Select all text CTRL+A
Select line of text CTRL+L
Display as wireframe CTRL+SHIFT+W
Copy text to clipboard CTRL+C
Paste clipboard contents CTRL+V
Change Quality settings ALT+Q



License terms
IMPORTANT NOTICE: The Xara3D software ("Software") is the copyright of Xara Limited ("Xara") whose principal 
place of business is at Gaddesden Place, Hemel Hempstead, Herts, HP2 6EX, United Kingdom and may not be 
stored on any computer or copied without the license of Xara.    You are offered a license on the terms of the End 
User License Agreement ("EULA") set out below. 
If you accept the terms of the License Agreement, select    "I ACCEPT".
Selecting I ACCEPT and installing the Software constitutes acceptance of the terms of the EULA. Please read 
carefully and accept the terms and conditions of the EULA before installing the Software.    Do not install    the 
Software if you do not agree to the terms and conditions of the EULA.
XARA3D END USER LICENSE AGREEMENT ("EULA")
You are permitted to:

(1) load or download the Software and use it only on a single client computer which is under your personal control;
(2) transfer the Software from one computer to another provided it is used on only one computer at any one time;
(3) make one copy of the Software for back-up purposes only in support of the permitted use.    The copies 

must reproduce and include Xara’s copyright notices;
(4) transfer the Software (complete with all its associated documentation) and this license to another person 

provided he has agreed to accept the terms of this Agreement and you contemporaneously transfer all copies 
of the Software you have made to that person or destroy all copies not transferred.    If any transferee does not 
accept such terms then this license shall automatically terminate.    The transferor does not retain any rights 
under this Agreement in respect of the transferred Software or license.

You are not permitted:
(a) to use the Software on any computer or system which permits electronic access to it by more than one user;
(b) to rent, lease, sub-license, loan, copy (except as expressly provided in this Agreement), modify adapt, 

merge, translate, reverse engineer, decompile, disassemble or create derivative works based on the whole or 
any part of the Software or its associated documentation except as permitted by law;

(c)except as expressly provided in this Agreement, to use, reproduce or deal in the Software in any way.
TERM
The license is effective until you terminate it by    destroying the Software and its documentation together with all 
copies.    It will also terminate if you fail to abide by this Agreement.    Upon termination you agree to destroy all 
copies of the Software and its documentation including any Software stored on the hard disk of any computer under
your control. If you are using the trial version of the Software then any rights to use the Software or images created 
with it terminates with the expiration of the trial period.
OWNERSHIP
You own only any CD-ROM (or authorized replacement) upon which the Software was supplied where it was not 
downloaded.    You may retain such CD-ROM on termination provided the Software has been erased. Xara shall at all 
times retain ownership of the Software as recorded on the original    CD-ROM and all subsequent copies thereof 
regardless of form.    This Agreement applies to the grant of the license only and not to the contract of sale of the 
CD-ROM. 
RESTRICTIONS
This license gives you the right to use images created with this Software with the following limitations:

1. The textures and fonts cannot be redistributed, sold or published in any form, commercial or otherwise.
2. Some fonts are provided by third parties who retain the copyright. In all cases copyright is reserved by Xara or 

its licensors and is protected by international copyright law.    
3. You may not use the images for any purpose which is prohibited by law.

WARRANTIES AND REMEDIES
1 Xara warrants that the storage media on which the Software may have been supplied will be free from defects 

in materials and workmanship under normal use for a period of    90 days after the date of original purchase. If a
defect in any CD occurs during such period you may return it with proof of purchase to your supplier who will 
replace it free of charge.

2 Xara warrants that the Software will perform substantially in accordance with its accompanying documentation 
(provided that the Software is properly used on the computer and with the operating system for which it was 
designed) and that the documentation correctly describes the operation of the Software in all material respects.
If Xara is notified of any significant error in the Software during the period of 90 days after the date of original 
purchase it will correct any such error within a reasonable time (by replacement if it chooses) or, at its option, 
refund the price of the Software (against return of the Software and its documentation).

3 The warranties set out in paragraphs 1 and 2 above are your sole warranties and are in place of all warranties 
conditions or other terms expressed or implied by statute or otherwise, all of which are hereby excluded to the 
fullest extent permitted by law. Paragraphs 1 and 2 also set out your sole remedies for any breach of    Xara’s 
warranties

4 In particular Xara does not warrant that the Software will meet your requirements or that the operation of the 



Software will be uninterrupted or error free or that all errors in the Software can be corrected. You load and use 
the Software at your own risk and in no event will Xara be liable to you for any loss or damage of any kind 
(except personal injury or death resulting from Xara’s negligence) including lost profits or    any indirect or 
consequential loss arising from the use of or inability to use the Software or from errors or deficiencies in it 
whether caused by negligence or otherwise, except as expressly provided in this Agreement.

CONSUMERS
Nothing in this Agreement shall affect your statutory rights as a consumer .
LAW
This Agreement shall be governed by English law.
If you have any questions concerning this Agreement please write to Xara Limited, Gaddesden Place, 
Hemel Hempstead, Herts, HP2 6EX, United Kingdom.
The bundled fonts and textures cannot be redistributed, sold or published in any form, commercial or otherwise. In 
all cases copyright is reserved by Xara or its licensors and is protected by international copyright law.



Notes on metafiles
Very complex shapes can take a long time to process. Some metafiles may be too complex for Xara3D to 

translate; in this case, only part of the shape is imported into Xara3D. If this happens, simplify the original shape 
and create a new metafile.

If the imported file contains 
only filled objects (for example, colored circles): these are imported.
only lines (also known as stroked paths) or unfilled objects: these are imported as outlines.
a mixture of filled objects and lines/unfilled objects: only the filled objects are imported.
bitmaps: these are not imported. Some packages such as Paint Shop Pro create metafiles that contain only 

a bitmap.
Some drawing packages convert curves to a series of polygons in the metafile. This is a feature of the 

drawing package. These polygons can be noticeable in Xara3D because the light catches the faces of the polygons. 
To reduce the effect, create the original drawing larger than required, then scale it down in Xara3D. A web page 
 shows this.

Some drawing packages can export both WMF & EMF format files. We recommend using EMF.



Other Xara products
Xara has a range of other products for web and general illustration work.
Xara Webstyle
Based on an easy-to-use template system, Webstyle lets you create a entire website designs and a wide range of 
graphics, including 2D & 3D headings, animated banner ads, NavBars, buttons, bullets and backgrounds. You can 
also 3, you can import and enhance your photos and create thumbnails, ideal for the Web. For full details see    
Webstyle web page     
Xara Menu Maker
The "little sister" of Xara Webstyle, Menu Maker lets you easily create multibutton, multi-state NavBars, with 
optional DHTML menus. Menu Maker automatically creates the HTML and JavaScript snippets needed for displaying 
the NavBars and menus. For full details see Menu Maker web page     
Xara X¹
Xara X¹ is drawing and illustration software, favored by some of the world's best artists for its speed, versatility and 
ease of use. It's great for web graphics as well as incredibly detailed illustrations. For full details see    Xara X web 
page     
ScreenMaker 3D
A 3D screensaver maker that's fast, fun and easy to use. Create animated 3D text message screensavers with your 
own personalized message. Or put any images of your choice onto the sides of a 3D, tumbling cubes screensaver 
For full details see ScreenMaker 3D     
BuyFonts.com
Different fonts allow you to create different designs. With prices starting at $2, BuyFonts.com meets all your font 
needs. For full details see BuyFonts.com web site     
Xara Online
Xara Online offers a range of online Web Services from animated photo and text effects to complete email, form 
and database management solutions. Add just a single line of HTML to your page, all the hard work is done on Xara 
Online's servers. For full details see Xara Online web site     



Positioning & rotating
To position or rotate the objects:

1.Drag on the window. The operation of this has been made as intuitive as possible. 
Hold down CTRL to move only horizontally.
Hold down SHIFT to move only vertically.

Alternatively you can use the vertical and horizontal scroll bars to rotate the objects vertically or horizontally.
If you want a precise rotation, hold down ALT and use the cursor (arrow) keys on the keyboard to change the 
rotation in 1 degree steps. SHIFT+ALT+ the cursor keys gives 15 degree steps.



Previewing AVI movies
To preview a movie:

1. Double-click on the movie file icon in a folder window.
However this uses the standard Windows 95 AVI player which plays the movie once and then closes the window. If 
you want to keep the movie on screen, right-click on the AVI file icon and select Open. When the movie player has 
opened, you can select the 'Auto-repeat' option that allows the AVI movie to cycle continuously.
Microsoft have a newer and more advanced movie playing solution, called ActiveMovie. This is available for free 
download on the Web. See www.microsoft.com/ie/download/     
You will need to select the OS type (Windows 95 and NT4) and then proceed to select ActiveMovie 1.0 for Windows 
95 and NT4.



Previewing GIF and JPEG files
The easiest way to see how your saved GIF or JPEG files will appear on the web is to preview using your web 
browser.
To preview GIF and JPEG files:

1. Drag the file from the folder in which you saved the file and drop it over your web browser window. This works 
for both Netscape and Microsoft Internet Explorer. The same applies to animated GIFs.

Note that Netscape versions prior to Navigator 4 do not get the timing right for animated GIFs - they always ran 
about half the speed they should. Navigator version 4 and Internet Explorer display animation with the correct inter-
frame timing.
See also
Previewing AVI movies



Quality Settings
This option on the Window menu lets you alter the quality settings for display and export. (Keyboard short cut 
ALT+Q.) Usually the default settings give excellent results, but you may wish to try different settings to fine-tune 
Xara3D to your requirements.

Screen Quality controls the quality of the on-screen display. Increasing the quality setting means that the 
preview takes longer to redraw on screen. Static and moving images have separate controls: animations can 
use a lower setting.
Anti-aliasing is a technique of blurring the edges between color transitions. Turning anti-aliasing on gives 
better results but takes longer to redraw.

Export Quality controls images exported as static bitmaps. Increasing the quality may give better results for 
some graphics in shadow or highlight areas. The drawback is that graphics may take longer to display on 
screen.

Animation Quality controls images exported as animated GIFs and AVIs. As the viewer sees each frame only 
briefly, the quality is less important than for static bitmaps. Note that increasing the quality too much can 
cause jerky animation on slow computers.



Saving an image
When you've positioned and sized the objects as required you will need to export the image as a bitmap. Xara3D 
can export the image as: BMP, PNG, GIF or JPEG static bitmap images, or either of two animating types - AVI movie 
and Animated GIF. 
If you want to make future edits, make sure you also save the file in X3D format - more details.
To save an image:

1. For static bitmaps choose Export Bitmap on the File menu.
For animations choose Export Animation on the File menu.
(Or click the Export button on the Toolbar. This exports an animation if the image is rotating otherwise a static 
image.)

2. Select the appropriate type from the drop down "Save as type" list on the export dialog box
3. Enter the required name.
4. Press OK. This displays the export options dialog box which provides all the control over the quality of image.    

Depending on which bitmap export type you’ve chosen you’ll get a number of different export options:
Export options for GIF, PNG, or BMP

    Export options for Animated GIF
    Export options for JPG
    Export options for AVI movies
Hint
While there are no hard and fast rules as to which file type, JPEG or GIF, is best for the web, we suggest trying GIF 
format first as this can produce higher quality images than JPEG. 
See also
Previewing GIF and JPEG files



Screen Saver
Not implemented in this release



Moving the shadow
You can move the shadow relative to the 3D objects. You can also move it closer to the objects or away from them.
To move the shadow:
The shadow is cast by a special light which does not affect the color of the 3D objects.

1.Select the Show Lighting light bulb on the Toolbar. This displays the three colored lights and the shadow light 
(striped arrow.)

2.Drag the shadow light. Shadows look "right" if they are slightly below and to the left or right of the text.
To move the shadow closer:

1.Hold down the ALT key and press the + (plus) key on the numeric keypad.
To move the shadow away:

1.Hold down the ALT key and press the - (minus) key on the numeric keypad.
To cancel any movement of the shadow:

1.Hold down the ALT key and press the * (asterisk) key on the numeric keypad.



Shadow dialog box
More information on using shadows.
Shadow
Select this to display a shadow.
Style

1 is a blurred copy of the objects. Artistically this is not a true shadow but it looks "correct" for simple drop 
shadows (the most common type on web pages.)

2 is a true shadow, thrown by the Shadow Light. This type looks best in animations where the eye is more aware 
of the shape of a shadow.

Color
Displays the Color Picker ready to change the shadow color. Normally the shadow is gray and shows some of the 
background color through.
Transparency
Controls how much of the background color or texture shows through the shadow. Semitransparent shadows are 
more realistic than solid shadows.
Blur
This can give the effect of either a pin-point light source (little blur) or diffuse light source (greater blur.) For best 
results we suggest always blurring the shadow slightly - in real-life shadows don't have sharp edges.



Technical support
We hope you don't have any problems with Webstyle but if you do, you will find a helpful list of FAQs on our web site
on    www.xara.com/support/Xara3D         These support pages are available 24 hours and can provide immediate 
answers to common questions. 
If the answer isn't on these support pages, you can contact our support department directly using the form on those
pages.



To control the size of the 3D objects:
You can control the size of the objects in two ways:

resizing the Xara3D window by dragging the bottom right corner, as you would normal windows
or specifying a size in points. Change the size using the Text Size field on the Text toolbar. Either type in a 

new value or select one from the drop down list.
To switch between the sizing options:

1.If the Text toolbar is not displayed at the bottom of the window choose Text Toolbar on the View menu.
2.In Font Size select Fit to Width to resize the text as you resize the window. Alternatively specify the text size in

points.
Everything in Xara3D is WYSIWYG - so with either method, the size you see in the window will be the size of the 
resultant image on your Web page. (Although you can override the size setting when you export the image.)
Xara3D uses one of the most advanced 3D rendering engines around. For instance, it automatically anti-aliases the 
image to produce the highest quality jaggy-free image. However as the anti-aliasing process can take a second or 
two, when you are ‘interacting’ with Xara3D (that is when you are dragging the text or altering other aspects in real
time, such as the lighting) the program produces a lower-quality non anti-aliased display. When you stop moving or 
altering things, the program automatically redisplays the top quality version. (You can use Quality on the Window 
menu to select on-screen quality.)



Text dialog box
If you have some text selected, any changes you make apply only to the selection. Otherwise changes apply to all 
text.

Bold - make the text bold. This button duplicates the Bold button on the Text Toolbar. Has no effect on 2D 
objects.

Italic - make the text italic. This button duplicates the Italic button on the Text Toolbar. Also slants any 2D objects.
Outline - select for outline text. This button duplicates the Outline button on the Text Toolbar.
Size - this lets you make 3D objects larger or smaller. Its main use is to change the size of selected characters. 

Size is relative so if you change Font Size (on the Text Toolbar) the characters scale in proportion.
Aspect Ratio - change the width relative to the height. This duplicates Aspect Ratio on the Text Toolbar.
Alignment - change the alignment (justification) of two or more lines of text. Has no effect for a single line of 

text. Duplicates the Alignment button on the Text Toolbar.
Line Spacing - changes the vertical space between lines of text (more details). This duplicates Line Spacing on 

the Text Toolbar.
Tracking - changes the horizontal space between characters (more details). This duplicates Tracking on the Text 

Toolbar.
Baseline Shift - move the selected text vertically. Keyboard short cuts: F7 shift up; F8 shift down.
Kerning - change the horizontal space between two characters. Dimmed if there is selected text. Keyboard short 

cuts: F5 reduce spacing; F6 increase spacing.
Note the difference between Kerning (which affects a pair of characters) and Tracking (which affects several 
characters.)

Font list - this lets you select the font (typeface). If you click on a font name, you can then scroll up and down 
the list using the arrow keys on the keyboard. The preview (on the right) then shows you how the text looks in 
the current font.

Preview window - shows you the text. You can select text in this preview (by dragging or using the arrow keys) 
and then apply any of the options in this dialog box to just the selection.



Texture dialog box
More information on using textures.
Size
Scales the texture bitmap. Only you know the best size for a particular heading. At large scalings, the individual 
pixels that make up the bitmap may become noticeable - this can create interesting effects. At smaller scalings you 
see multiple copies of the bitmap.
X
Move the bitmap sideways. This lets you position the bitmap precisely on the heading. Movement is relative to the 
bitmap size - for a small bitmap (as you get with low values of Size), movement is less noticeable. Note that if you 
rotate the texture, you also rotate the angle of X movement.
Y
Move the bitmap vertically. Similar to X.
Angle
Rotate the texture.
Load texture
Opens the Load Text Texture dialog box. This duplicates Text Texture on the View menu.



The basics
To create a 3D heading you just enter the text and the font for the heading, then adjust the bevel and extrude if you
wish (using the B and E buttons). Finally drag the text and resize the image window so that you’ve got it to be the 
right size and angle. Then just select the Export menu option to save the image as a PNG, GIF, animated GIF, AVI or 
JPEG.



Tips for reducing the size of Animated GIF files
Images of any type that are larger than, say, 50K are not really welcomed by Web users.
Make the image as small as possible by selecting the Crop option on export.
Select 'Front face only' and have no more than about 20 frames per revolution.
When exporting try selecting 16 colors (4-bit) with no dithering and optimized palette. When images are 

animating, the banding is far less obvious than with a static image.
When exporting GIFs (animated or static) that have a complex background, try exporting them as 

transparent GIFs. 
Rotating the lights changes the file size only slightly.



Uninstalling Xara3D
To keep the download size small Xara3D doesn't include an uninstall option. However uninstalling is simple:

1. delete the folder containing Xara3D
2. right-click on the Start menu on the Taskbar, and select Open
3. double-click on Programs. This displays the contents of the top level menu with Xara3D shown at the 

bottom
4. delete the Xara3D shortcut



Upgrading to Xara3D 6 will give you many great new features.

Find out more about what's new in Xara3D 6. You can also download a free 15 day trial of Xara3D 6 at 
our website at xara.com/xara3d  and see examples of what can be achieved with this new version, or 
use the copy that is on this CD. There is also a movie to introduce you to Xara3D 6, which you can 
access from the Xara3D 3 splash screen on startup.

As a registered owner of this covermount version of Xara3D 3, you are entitled to a significant discount on
Xara3D 6. It will only take a couple of minutes to register this copy, simply select the register option on the
starting splash panel of this version of Xara3D 3, making a note of the email address and password you 
choose during registration.

You can purchase Xara3D 6 by either clicking the Upgrade option on the starting splash panel of this 
version of Xara3D 3, or the purchase links within the Xara3D 6 trial. As soon as you enter your email 
address and password during the purchase process, the price will be adjusted to the discount price.



Using a texture to color the objects:
You can use a bitmap texture to color the objects. Use Text Texture on the View menu to select a bitmap. You can 
also drag-and-drop textures onto the objects. You can use any BMP, PNG, JPEG or GIF file. For light colored textures 
you can use the normal lighting. Darker textures need bright lights (white or pale colors) to give the best results.
You can change the size, position and angle of the texture from the Texture dialog box. (Texture on the Window 
menu or ALT+X.) If you make the bitmap smaller than the heading, you see multiple copies of the bitmap. This 
dialog box lets you create a wide range of effects.
Note for Version 2 users:
The texture is now stored in the X3D file. If you give the X3D file to someone, you no longer need to give them the 
texture file as well. 
See also:
Altering the text color



View menu
Text Color
Display the Color Picker ready to edit the color of the text. More details of coloring text.
Text Texture
Select a bitmap texture to display on the surface of the text. More details of using textures.
Background Color
Display the Color Picker ready to edit the color of the background.    More details of changing the background color.
Background Texture
Select a bitmap texture to display as the background. More details of using textures.
Display Lighting
Show the three colored lights. You can then change their positions or, by double-clicking, their color. More details on
the lights.
Light Source 1
Display the Color Picker ready to edit the color of Light 1. More details on the lights.
Light Source 2
Display the Color Picker ready to edit the color of Light 2. More details on the lights.
Light Source 3
Display the Color Picker ready to edit the color of Light 3. More details on the lights.
Shadow Color
Display the Color Picker ready to edit the color of the shadow. More details on shadows.
Start/Stop Animation
Start or stop the on-screen animation. More details on animation options.



What does this do...?
Use these pages to find out more about the menu options or the dialog boxes.
The menus

File menu
Edit menu
View menu
Window menu

Dialog boxes
Animation dialog box
Bevel dialog box
Extrusion dialog box
Shadows dialog box
Text dialog box
Texture dialog box

The Color Picker
Use this to change colors in Xara3D.



What's new in Xara3D 6
Upgrade to Xara3D 6
The latest version of Xara3D has many great new features and if you register this version of Xara3D3 you can 
upgrade at a discounted price.    These are just some of the benefits of the upgrading:

- A completely revised user interface that makes Xara3D 6 even easier to use, including interactive on-screen 
dragging of the extrude and bevel, and docking toolbars
- some great animation enhancements including wave effects, multi-page animations, loop control, many new 
animation types and an animation timeline
- export as Flash
- save any 3D animation as a screensaver
- a free copy of our illustration software Webster 2 (sold for $49) which can export directly into Xara3D. Which 
means you can now freely create your own 2D shapes and extrude them into 3D!
- easily copy the attributes of any existing file to your current heading using the new animation and style 
pickers
- apply animation types, textures, colour, extrusion and bevel type to individual characters
- an easy to use design tool which converts your heading into buttons, or adds a border or background board 
with a single click
- separate control over the front and side colours or textures of a graphic
- many new bevel types
- a CD with over 700 example images, 400+ textures, 60 fonts and a tutorial movie

You can also download a free 15 day trial of Xara3D 6 at our website at xara.com/xara3d  and see 
examples of what can be achieved with this new version, or use the copy that is on this CD. There is also 
a movie to introduce you to Xara3D 6, which you can access from the Xara3D 3 splash screen on startup.

More on Xara3D 6     



Window menu
Text
Open the Text Options dialog box. This dialog box provides a range of options for changing the appearance of text. 
More details on this dialog box.
Extrude
Open the Extrusion Options dialog box. This lets you change the depth of the 3D extrude. More details on this dialog
box. More details on extruding.
Bevels
Open the Bevel Options dialog box. More details on this dialog box. More details on changing the bevels.
Shadow
Open the Shadow Options dialog box. More details on this dialog box. More details on shadows.
Texture
Open the Texture dialog box. More details on this dialog box. More details on textures.
Animate
Open the Animation Options dialog box. More details on this dialog box. More details on creating animations.
Quality Settings
Change the on-screen viewing quality. More details.
Toolbar
Display the Toolbar at the top of the window.
Text Toolbar
Display the Text Toolbar at the bottom of the window.
Status Bar
Display the Status Bar at the bottom of the window.



Notes on Xara WEB/XAR files
These are produced by Xara X      and Webster 2     
 (Webster 2 is free to purchasers of Xara3D5.)

When you purchase Xara3D5, you receive a CD. Installing from the CD automatically installs the Xara file 
importer. 

To keep the download small, the file importer is not included with the trial version of Xara3D. You can 
download it separately from

www.xara.com/xara3d/plugin.html 
Notes on imported files:

Line widths are ignored.
Dash patterns, joins, end caps, and arrows on lines are ignored.
Objects on all visible layers are imported.
Objects on the current frame are imported; other frames are ignored.
Bitmaps are ignored.
If the imported file contains 
only filled objects (for example, colored circles) or text: these are imported.
only lines or unfilled objects: these are imported.
a mixture of filled objects/text and lines/unfilled objects: only the filled objects/text are imported.



Saving for reloading later
You can save Xara3D graphics in two types of format:

as Xara3D X3D files. You can reload these into Xara3D for further editing but cannot use them on web 
pages.

as bitmaps (PNG, GIF, JPEG, or AVI.) You cannot edit these in Xara3D. Saving in these formats. GIF or JPEG 
are best for static images on the web, Animated GIF for animated buttons.
So if you want make future changes to a graphic, make sure you save it in X3D format.
To save in X3D format:

1.Click the Save icon on the Toolbar. For a new graphic, you are prompted to type in a name.
You can also use Save on the File menu. Or Save As to save under a different name.



Changing the blur of the shadow
This can give the effect of either a pin-point light source (little blur) or diffuse light source (greater blur.) For best 
results we suggest always blurring the shadow slightly - in real-life shadows don't have sharp edges.

1.Click the Shadow Options button on the Toolbar.
2.Type a value into Blur.

See also:
displaying or removing the shadow
changing the shadow style
changing the shadow color
changing the shadow transparency
moving the shadow relative to the 3D objects



Changing the color of the shadow
1.Double-click on the shadow. This displays the Color Picker.
2.Edit the color.

Note: you can also click the Shadow Options button then click Color.
See also:

displaying or removing the shadow
changing the shadow style
changing the shadow transparency
changing the shadow blur
moving the shadow relative to the 3D objects



Displaying/removing a shadow
1.Click the Shadow Options button on the Toolbar.
2.Select Shadow to display a shadow.

See also:
changing the shadow style
changing the shadow color
changing the shadow transparency
changing the shadow blur
moving the shadow relative to the 3D objects



Changing the transparency of the shadow
This controls how much of the background color or texture shows through the shadow. Semitransparent shadows 
are more realistic than solid shadows.

1.Click the Shadow Options button on the Toolbar.
2.Type a percentage into Transparency.

See also:
displaying or removing the shadow
changing the shadow style
changing the shadow color
changing the shadow blur
moving the shadow relative to the 3D objects



Changing the shadow style (type)
This controls the angle of the background.

1.Click the Shadow Options button on the Toolbar.
2.Select 1 or 2.

1 is a blurred copy of the objects. Artistically this is not a true shadow but it looks "correct" for simple drop 
shadows (the most common type on web pages.)
2 is a true shadow, thrown by the Shadow Light. This type looks best in animations where the eye is more 
aware of the shape of a shadow.

See also:
displaying or removing the shadow
changing the shadow color
changing the shadow transparency
changing the shadow blur



Shadows and Backgrounds
Because Xara3D shadows are semi-transparent, to ensure the best, most effective results on web pages make sure 
Xara3D is using the same background GIF or JPG file as your web page. You can save a web page background to 
your local disc by using the right mouse button. Click over a part of the background in a browser window and select 
Save Background As. You can then just drag and drop the file onto the Xara3D background.
GIF files (especially animated GIF files) with soft shadows over background textures are larger than those with no 
soft shadow.
 



Typing international (accented) characters
Xara3D lets you enter a wide range of accented characters using "dead keys". These work by:

1.pressing CTRL+the accent character then 
2.typing the regular character.

So, for example, to enter è (e grave) you first type CTRL+' (single quote) then type e. Common accent characters 
are 

' ` ,^ " ~ / for è é ç ê ë ã Ø
Not all fonts include a full set of accented characters. This is a feature of the font and beyond the control of

Xara3D.
If you know their number, you can enter characters by holding down ALT and typing the number on the 

numeric keypad. For example ALT+0233 gives é.
There's more details on a web page .



Typing characters as normal adds them to the end of the text. Or you can Import a 2D object.



BACKSPACE deletes characters from the end of the line.



To change the alignment of two or more lines of text
(Also known as Justification.)
Click the three align buttons on the Text Toolbar at the bottom of the window. These buttons have no effect for a 
single line of text.



To change spacing between lines of text
Change Line Spacing on the Text Toolbar (displayed at the bottom of the window.) This value is a percentage of the 
regular line spacing. 100% is regular spacing. Less than 100% moves the lines closer together. Line spacing has no 
effect for a single line of text.
This always affects the entire line. To move selected characters vertically, use Baseline Shift on the Text dialog 
box. Or use F7 to move the selection upwards; F8 downwards.



Editing text in the middle of a line
1. Click the Show/Hide Cursor button (the I-beam) on the Text Toolbar to select it. This displays a vertical cursor.
2.Use the arrow keys on the keyboard to move the cursor.
3.You can then type in new text or delete existing text using BACKSPACE or DELETE.



Press ENTER to start a new line.



To change selected characters
(For example to a different font.)
The first step is to select the characters you want to change:

1. Click the Show/Hide Cursor button (the I-beam) on the Toolbar to select it. This displays a vertical cursor.
2.Using the arrow keys on the keyboard to move the cursor to where you want the selection to start.
3.Use SHIFT+arrow keys to select characters. 

Any options you change on the Text Toolbar    or Text dialog box then apply to the selected characters only.



Changing the spacing between characters
To change the spacing between several or all characters:

1.Change the value in Tracking on the Text Toolbar (displayed at the bottom of the window.) Tracking is 
measured in ems. One em is the width of the letter 'M' in the current font.
If there is some text selected, the tracking change applies just to the selection. (See Selecting text.) Otherwise 
the change applies to all characters.

You can also use the Text dialog box.
To change the space between two characters:

1.Open the Text dialog box.
2.In the dialog box move the cursor between the two characters.
3.Change the value in Kerning. Positive values increase the space between characters; negative decreases the 

space.
Keyboard short cut: 

F5 reduce spacing
F6 increase spacing



To make the objects wider or narrower
Change Aspect Ratio on the Text Toolbar (displayed at the bottom of the window.) 100% is regular width. Less than 
100% compresses the characters. Note the difference between Aspect Ratio (change the width of characters) and 
Tracking (change the space between characters.)



Importing 2D objects
As well as using regular text in Xara3D, you can also import 2D objects and extrude them. 2D objects can be in 
Windows metafile .EMF or WMF format or Xara .XAR or .WEB format.
After importing you can recolor, scale, and extrude 2D objects in exactly the same way as text. You can even slant 
the text using the Italic option on the Text Toolbar.
To import a 2D object (add to the existing heading):

1.Choose Import on the File menu.
2.Select Windows Metafile or Xara filter as the file type.
3.Browse to the folder containing the EMF, WEB, WMF, or XAR file.
4.Click Open to import. This adds the 2D object to the end of any existing text or 2D objects.

To open a new document showing only a 2D object:
1.Choose Open on the File menu.
2.Select Windows Metafile or Xara filter as the file type.
3.Browse to the folder containing the EMF, WEB, WMF, or XAR file.
4.Click Open to import. This opens a new document containing only the 2D object.

Notes:
Simple shapes work best. Complex shapes often lose detail when converted to 3D.
Any color information in the imported file is discarded. The 2D objects take the current text color.
More information on XAR/WEB files
More information on metafiles

See this web page  for the latest information on importing 2D objects.




